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Chapter 11 - Sections & Objectives

 11.1 Windows Desktop and File Explorer
 Configure the Windows Desktop and File Explorer

– Compare versions of Windows 7, 8, 8.1, and 10.
– Use features of the Windows desktop.
– Use Windows Task Manager to manage running processes and services.
– Use File Explorer to manage files, folders, and applications.
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 11.2 Configure Windows with Control Panels
 Configure Windows using Control Panels

– Use Microsoft Windows control panel utilities.
– Configure user accounts with control panels.
– Configure internet and network connectivity using control panels.
– Configure Windows display settings.
– Use System and Power Options control panels.
– Use hardware and sound control panels.
– Use the clock, region, and language control panels or settings to configure a 

computer for a location.
– Use the Programs and Features control panel to manage Windows software.
– Explain how the Windows troubleshooting control panel to investigate system issues.
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 11.3 System Administration
 Use Windows tools and utilities to manage Windows systems.

– Manage system resources with Microsoft Windows utilities.
– Use Microsoft Windows utilities to manage system operation.
– Manage system volume storage with Microsoft Windows utilities.
– Manage software applications.
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 11.4 Command-Line Tools
 Use Microsoft Windows command line tools..

– Use the Windows command window CLI.
– Use file system CLI commands to work with the Windows file system.
– Use disk CLI commands to work with Windows disks.
– Use task and system CLI commands to control Windows operation.
– Use other CLI commands to accomplish Windows tasks.
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 11.5 Windows Networking
 Configure a Windows computer to work on a network.

– Configure a Windows computer to share resources on a network.
– Configure local resources to be shared with other network users.
– Configure wired network interfaces in Windows.
– Configure wireless network interfaces in Windows.
– Use Windows applications to access remote computers.
– Use remote Windows Remote Desktop and Remote Assistance to work with 

remote computers.



ITE v7.0 7

Chapter 11 - Sections & Objectives

 11.6 Common Preventive Maintenance Techniques for Operating Systems
 Use common preventive maintenance techniques for Microsoft Windows 

operating systems.
– Perform preventive maintenance on a computer using Microsoft Windows 

tools.
– Perform system restore procedures.
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 11.7 Basic Troubleshooting Process for Windows Operating Systems
 Troubleshoot Microsoft Windows operating systems.

– Explain the six steps of troubleshooting a Microsoft Windows operating 
system.

– Describe common problems and solutions related to Microsoft Windows 
operating systems.

– Troubleshoot advanced Windows operating systems problems.
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11.1 WINDOWS DESKTOP AND FILE 
EXPLORER
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Windows Versions

 Since 1985 there have been over 25 versions of Windows.
 Windows comes in 32-bit or 64 bit editions.
 In the case of Windows 10, twelve editions 

were developed and released, however, 
only nine are currently offered.
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Windows 7

 Released in October 2009, Windows 7 was quite successful.
 Offered improvements to the interface, taskbar, performance, and File Explorer, 

including the first appearance of Libraries and HomeGroup file sharing.
 Microsoft offers extended support for Windows 7 until January of 2020.
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Windows 8

 Released in October 2012, Windows 8 included a major revision in the Windows 
interface.

 Windows 8 was designed to be more compatible with mobile devices (touch 
screen, tablets and mobile devices).

 Anti-virus included with the OS.
 Windows Explorer was changes to File Explorer.
 The interface changes were unpopular and made it difficult for some users to 

learn.
 Microsoft ended support for Windows 8 until January of 2016.
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Windows 8.1

 Windows 8.1 was released one year after Windows 8 in October 2013.
 Windows 8.1 included a Start screen familiar to users (similar to Windows 7), and 

a full Start menu button in the taskbar.
 It included new functionalities and easier configuration options for the desktop 

GUI interface.
 Microsoft will end support for Windows 8.1 in January of 2023.
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Windows 10
 Windows 10 was released in July 2015.
 Windows 10 offers a return to a desktop-oriented interface.
 Windows 10 combines menu entries and tiles in the Start menu.
 Windows 10 supports universal apps that run on desktop and mobile devices.
 Windows 10 introduced the Microsoft Edge web browser.
 Charms were replaced with the Windows Action Center with notifications and 

quick settings.
 New update model with feature updates twice yearly and quality or cumulative 

updates monthly.
 Microsoft will end support for Windows 10 in October of 2025.



ITE v7.0 15

Windows Desktop, Tools and Applications

 Windows Desktop
• A graphical representation of the workspace, often called GUI.
• The desktop has icons, toolbars, and menus to manipulate files.

 Desktop Properties
• The Windows desktop is highly customizable.
• Possible customizations include: re-arrange titles, change 

colors and sounds, modify screen resolution.
 To customize the desktop in Windows 7, 8, 8.1 and 10, 

right-click anywhere on the desktop and choose Personalize to:
• Change desktop icons, mouse pointers, and your account picture. 
• Modify a theme’s background, color, sound, and screensaver.
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The Windows 7 Desktop
 Windows 7 has a default theme named Aero.
 Windows 7 Versions and above have the following features:

• Shake – minimize all windows not being used 
by clicking and shaking the window.

• Peek - View the desktop icons that are behind 
open windows by placing your cursor over the 
Show desktop button found at the right edge of 
the taskbar.

• Snap - Resize a window by dragging it to one 
of the edges of the screen.

 Gadgets are small applications, such as games, sticky notes, a calendar, or a 
clock, that can be places on the desktop.

 Microsoft has retired the Gadgets feature in versions following Windows 7 
because of security concerns.



ITE v7.0 17

The Windows 8 Desktop

 Windows 8 desktop included:
• Tiles on the Start screen
• Desktop optimized for mobile devices
• Revised task manager
• Ribbon menu on the File Explorer 
• Windows Defender native antivirus
• Charms bar of five icons, accessed by placing 

the cursor in the upper-right corner of the 
screen or swiping your finger in from the right 
side of the screen on a touchscreen.
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The Windows 8.1 Desktop

 The Windows 8.1 desktop interface includes:
• Taskbar
• Start button
• Pinned program icons
• Clicking the Start button displays the Start 

screen that is very similar to the Windows 8 
Start screen.
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Personalizing the Windows Desktop

 Themes - fastest way to change the look and feel of the 
Windows GUI.

 Apps Environment - desktop start screen
• Tiles - click and drag the tiles to rearrange them. 
• Start screen - right-click the desired Windows app 

and select Pin to Start.
• Search - start typing the name of the app to auto 

search.
 Personalization Window - you can change the 

desktop appearance, display settings, and sound 
settings.
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The Windows 7 Start Menu

 The Start Menu displays:
• All of the applications installed on the computer 
• A list of recently opened documents 
• A list of other elements, such as the search feature, 

Help and Support, and Control Panel
 To customize the Start Menu in Windows 7 right-click 

an empty section of the taskbar and choose Properties 
> Start Menu > Customize
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The Windows 8.1 and 8.0 Start Menu

 Windows 8.1 Limited Start Menu

Windows 8 Start screen and Apps screen



ITE v7.0 22

The Windows 10 Start Menu

Shortcuts to common libraries, 
including settings and shutdown 

buttons

Applications in alphabetical order, 
including most used and recently 

installed

Tiles for Apps arranged by category, such as 
games, creative software, etc.
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The Taskbar

 The Start Menu displays:
• All of the applications installed on the 

computer
• A list of recently opened documents 
• A list of other elements, such as the search 

feature, Help and Support, and Control Panel
 To customize the Start Menu in Windows 7, 

right-click an empty section of the taskbar and 
choose Properties > Start Menu > Customize
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Windows Task Manager Functions

• Processes – a set of instructions started by the user, a program, or the OS.
• Performance – dynamic system performance graphs for a variety of options, 

including CPU, Memory, Disk, Ethernet, etc.  
• App History – displays historical resource utilization such as CPU time, network 

data usage, data uploads and downloads.
• Startup – shows the processes that automatically begin during Windows startup.
• Users – shows who is currently connected to the PC and the system resources 

they are using.
• Details – makes is possible to change the level of COU priority for a given 

process.
• Services – shows all available services and their status.
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Task Manager in Windows 7 

 Windows 7 Task Manager has six tabs:
• Applications – shows all running applications. You can create, switch to, or 

close any applications.
• Processes - this tab shows all running processes. 

You can end processes or set process priorities.
• Services - available services, including their 

operational status. Services identified by their PID.
• Performance - This tab shows the CPU and page 

file usage.
• Networking - This tab shows the usage of all 

network adapters.
• Users - This tab shows all users that are logged on 

the computer.
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Task Manager in Windows 10 

 Task Manager Differences in Windows 10:
• Applications and Processes tabs have been combined in Windows 10.
• Networking tab is included with the Performance 

tab in Windows 10.
• Users tab has been enhanced in Windows 10 to 

not only show the users that are connected but 
also the resources that they are using.
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File Explorer 

 File Explorer is used for file management in Window 8 and Windows 10.
 Windows Explorer is used for file management in Windows 7 and earlier.
 The Ribbon is used for common tasks, such as copying and moving files and 

creating new folders.
 The Tabs at the top change based on what is 

selected.
 File Explorer is used to:

• Navigate the file system
• Manage files, folders and subfolders
• Manage applications on storage media
• Preview some types of files
• Mount an ISO image using Disk Image tools
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This PC 

 In Windows 10 and 8.1, the This PC
feature allows you to access the various 
devices and drives installed in the 
computer.

 In Windows 7, this same feature is 
called Computer.

 To open This PC, open File Explorer, 
and it will display the This PC feature by 
default.

 In Windows 8.0, or 7, click Start and 
select Computer.
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Run as Administrator 

 Modern operating systems improve security by only allowing users with enough 
permissions to access files. 

 System files, other user files, or files with elevated permissions are examples of 
files that could lead Windows to deny access to a 
user. 

 To override this behavior and gain access to 
those files, you must open or execute them as the 
system administrator.

 To open or execute a file using elevated 
permission, right-click the file and choose Run as 
Administrator as shown in the figure. Choose Yes
in the User Account Control (UAC) window. 
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Windows Libraries 

 Windows Libraries allow you to easily organize content including removable 
media, without actually moving the files.

 A library is a virtual folder that presents content from different locations within the 
same view. 

 When Windows 10 is installed, each 
user has six default libraries, as shown 
in the figure.

 In Windows 10 and Windows 8.1, the 
libraries are hidden by default.

 Right-click the left pane of the File 
Explorer window for the context menu 
option that can show the libraries.
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Directory Structures 

 The root level of the Windows directory structure, the partition, is usually labeled 
drive C. 

 Directories may contain additional 
directories called subfolders. 

 The number of nested folders is limited by 
the maximum length of the path to the 
folders. 

 In Windows 10, the default limit is 260 
characters. 

 The figure shows several nested folders in 
File Explorer along with the equivalent path.
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User and System File Locations 
• Users Folder – Windows stores more of the files created by users in the Users 

Folder, C:\Users\User_name\.
• System Folder – Most files used to run a Windows OS computer are found in the 

folder C:\\Windows\system32.
• Program Files – This folder is used by most application installation programs to 

install software.
 Program Files (x86) – Used by application 

installation programs to install software. All 
32-bit programs are installed in this folder.

 Temporary Files – Contains files created by 
the OS and programs that are needed for a 
short period of time and are usually 
automatically deleted when the application 
or the OS is finished using them.
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File Extensions 

 In Windows 10 and Windows 8.1 in the 
File Explorer ribbon, click the View tab. Then 
click to check File name extensions.

 Files adhere to the Windows naming convention:
• A maximum of 255 characters is allowed
• Characters such as a slash or a backslash 

(/ \) are not allowed
• An extension of three or four letters is 

added to the filename to identify the file 
type

• Filenames are not case sensitive
• By default, file extensions are hidden

 Windows filename extension examples:
• .docx- Microsoft Word
• .txt - ASCII text only
• .jpg - graphics format
• .pptx - Microsoft PowerPoint
• .zip - compression format 
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File Attributes 
 These are the most common file 

attributes:
• R - The file is read-only.
• A - The file will be archived 

the next time that the disk is 
backed up.

• S - The file is marked as a 
system file, and a warning is 
given if an attempt is made to 
delete or modify the file.

• H - The file is hidden in the 
directory display.
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11.2 CONFIGURE WINDOWS WITH 
CONTROL PANELS
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Windows 10: Settings and Control Panels

 Windows 10 offers two ways to configure the operating system

The Settings app The Control Panel
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Introduction to Control Panel

 System Admins prefer the Control 
Panel to the Settings App.

 To start the Control Panel, type 
Control Panel into the Search box 
and click the Control Panel Desktop 
app that appears in the results.

 If you right-click on the result, you 
can pin it to the Start menu to make 
it easier to find. 

 You can also open it from the 
Command Prompt by typing control.
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Control Panel Views

 The Windows 10 Control Panel opens to the Categories view by default.
 Both views also provide a search box which will return a list of Control Panel items.

Category View Small Icons View
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Define Control Panel Categories

 System & Security – provides access to administrative tools for configuring 
security and a wide range of system functions. View and configure security 
settings such as Windows Defender Firewall.

 Network & Internet – allows configuration of networking, file sharing, the default 
Microsoft browser, and infrared file exchange settings. Configure, verify, and 
troubleshoot networking and file sharing.

 Hardware & Sound – provides access to configuration of devices such as 
printers, media devices, power, and mobility. Configure devices such as printers, 
media devices, power, and mobility.

 Programs – provides access to allow activation or 
deactivation of a wide range of Windows features. 
Change installed programs and Windows updates, 
including removal.
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Define Control Panel Categories

 User Accounts – enables administration of Windows user accounts and 
management of Web and Windows Credentials including the file encryption 
certificates and user account control (UAC).

 Appearance and Personalization – Configure taskbar and navigation, file 
explorer, and available fonts.

 Clock and Region – Configure time and date settings and formats.
 Ease of Access – provides access for configuration of speech recognition and 

text to speech services. Access options that make Windows easier to use, 
especially for people who require accommodations 
for physical or perceptual challenges.
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User Accounts

 The User Accounts Control Panel provides options to help you create, change, 
and delete user accounts.

 An administrative account is created when Windows is installed.
 To create a user account, open the User Accounts Control Panel.
 Standard user accounts can manage most 

configuration settings that don't affect other users. 
 Standard user accounts can only access their own 

files and folders.
 Some features of the User Accounts utility require 

administrative privileges and will not be accessible 
with a standard user account.
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User Account Control Settings

 The User Account Control (UAC) monitors programs on the computer and 
warns users when an action might present a threat to the computer. 

 In Windows versions 7 through 10, you can adjust the level of monitoring that the 
UAC performs.

 The default UAC setting for the primary 
account is "Notify me only when programs 
try to make changes to my computer“.

 Adjust the UAC level to change when you 
are notified about changes that programs 
may make to your computer. 
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Credential Manager

 Credential Manager helps you to manage passwords that are used for websites 
and Windows applications.

 These passwords and usernames are stored in a secure location. 
 You can view, add, edit, or delete the 

credentials that are stored by Credential 
Manager.

 Web credentials are not saved for sites 
accessed by browsers other than Internet 
Explorer and Edge.
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Sync Center
 Sync Center allows files to be edited from multiple Windows devices.
 Sync Center allows a form of version control.
 Using Sync Center requires activation of 

the Offline Files feature. This sets up a 
local file location that will store the files 
to be synchronized. It also requires you 
to set up a sync partnership with the 
networked file location. 

 Files can be synchronized manually and 
synchronization can also be scheduled to 
occur automatically.

 Microsoft OneDrive offers a similar 
service. OneDrive is a cloud storage 
service that is available to Microsoft Windows users.
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Network Settings

 The Network Status app in Windows 10 combines many different functions into 
one high-level app.  

 The Network Status App links to various 
other Settings App screens.

 It also links to Control Panel items like the 
Network and Sharing Center.

 Some of the options, such as Airplane 
Mode, Mobile Hotspot, and Data Usage 
are more relevant to mobile devices than 
to desktop computers.

 Mismatched speed and duplex may cause 
network connection issues.
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Internet Options

 General tab – Allows for selecting 
the default home page, viewing 
and deleting browsing history, 
adjusting search settings, and 
customizing the browser 
appearance.

 Security tab – Allows for selecting 
zones for Internet websites that 
are trusted or restricted and the 
types of information allowed.

Security TabGeneral Tab
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Internet Options

 Privacy tab – Allows for 
adjustments to access private 
information (cookies or location), 
pop-up blockers and toolbars.

 Content tab – Allows for 
adjustment of AutoComplete 
settings, and configuration of the 
feeds and web slices that can be 
viewed in IE.

Content TabPrivacy Tab
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Internet Options

 Connections tab – Allows for 
Dial-up, VPN, and Proxy Server 
settings to be configured.

 Programs tab – Allows IE to 
be set as the default web 
browser, enables browser add-
ons, allows for the HTML editor 
to be set for IE, and allows for 
the selection of programs used 
for internet services.

Programs TabConnections Tab
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Internet Options

 Advanced tab – Allows for IE settings to be reset to their 
default state.

Advanced Tab
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Network and Sharing Center
 Network and Sharing Center allows an administrator to configure and review 

nearly all network settings on a Windows computer.
 View network status and internet connectivity.
 Change properties of protocols and services running 

on a network adapter.
 Configure file and device sharing through the use of 

network profiles.
 Network profiles enable basic sharing settings to 

change depending on whether it is a private or public 
network. This enables sharing to be inactive on an 
insecure public network but active on a private 
secure network.

 Profiles can be automatically synced when a user signs
into the same Microsoft account on multiple devices.

Windows 10



ITE v7.0 51

HomeGroup

 Homegroups is simplify sharing files on simple networks.
 They are intended to make networking in the home easier by requiring a minimum of 

configuration.
 You can share your library folders on the network, making it easy for other devices to 

access your music, videos, photos, and documents.
 Users will need the homegroup password in order to join 

the homegroup and access shared resources.
 Homegroups were used in Windows 7 and 8 but Microsoft 

has been phasing out the homegroup functionality. 
 In Windows 8.1 homegroups cannot be created, however 

Windows 8.1 computers can join existing home groups. 
 In newer versions of Windows 10 (version 1803 and 

higher), home group functionality is not available.
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Display Settings and Configuration

 The Windows 10 display settings are reached by 
right-clicking an empty area of the desktop and 
selecting Display settings from the context menu.

 Change the appearance of the desktop by modifying 
the resolution that is output by the graphics adapter.

 If the screen resolution is not set properly, you might 
get unexpected display results from different video 
cards and monitors.

 You can also change the magnification of the 
desktop and text size in Windows interface 
elements.

Display Settings in Windows 10
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Display Features
 Windows 8 and 7 Display control panel item:

• Display - configure multiple monitors
• Screen resolution - number of pixels horizontally and vertically. Higher numbers 

provides better resolution, 1920 x 1080 for example
• Orientation - This determines whether the display appears in Landscape, Portrait, flipped 

Landscape, or flipped Portrait orientation
• Refresh rate - how often the screen image is redrawn 

expressed in Hertz (Hz). The higher the refresh rate, 
the steadier the screen image appears

• Display colors - The higher the bit depth, the greater 
the number of colors. 

• Multiple displays - two or more monitors attached to 
the same computer. The desktop can be extended to 
make one large display, or mirrored, with the same 
image shown on all displays
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Power Options

 Power Options Control Panel allows you to change the power consumption of 
certain devices or the entire computer.

 Use Power Options to maximize battery performance or conserve energy by 
configuring a power plan.

 One important difference from Windows 7 and 8 
is that the setting that requires a password when 
the computer wakes has been moved from Power 
Options to User Accounts in Windows 10. This is
an important setting for data security.

 Windows has preset power plans. Use the default 
settings or create your own customized plans.

 Note: Power Options settings will vary based on 
the hardware that is detected. Power Options Control Panel in Windows 10
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Power Options Settings

 In Windows 8 you can choose from the following options:
• Require a password on wakeup (Windows 7 and 8 only)
• Choose what the power buttons do
• Choose what closing the lid does (for 

laptops only)
• Create a power plan
• Choose when to turn off the display
• Change when the computer sleeps
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Power Options Actions

 If users do not want to completely shut down a computer, the following options may be 
available:
• Do nothing - The computer continues to run at full power.
• Sleep – Documents, applications, and the state of the OS are saved in RAM. 

This allows the computer to power on quickly.
• Hibernate – Documents, applications, and the state of 

the OS are saved to a temporary file on the hard drive. 
With this option, the computer takes a little longer to 
power on than the Sleep state, but does not use any 
power.

• Turn off the display - The computer operates at full 
power. The display is turned off.

• Shut down - Shuts down the computer.
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System Control Panel Item

 The System Control Panel item allows all users to view basic system information, 
access tools, and configure advanced system settings. 

 The Windows 10 System Control Panel item is shown here. The System Control 
Panel item is very similar in Windows 7 and 8.

 The various settings can be accessed by clicking 
the links on the left panel.
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System Properties

 Computer Name – View or change the computer name, workgroup, or domain
 Hardware – Access the Device Manager or adjust the device installation settings.
 Advanced – Configuration settings for performance, 

user profiles, startup and recovery.
 System Protection – Access system restore and 

enable system restore points and the amount of disk 
space to store them .

 Remote – Adjust settings for remote assistance and 
remote desktop.
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Increasing Performance

 To enhance the performance of the OS, you can change the virtual memory 
configuration settings, as shown in the figure.

 When Windows determines that system RAM is insufficient, it will create a paging 
file on the hard drive that contains some of the data from RAM.  

 This process is much slower than accessing 
RAM directly. If a computer has a small amount 
of RAM, consider purchasing additional RAM.

 Another form of virtual memory is the use of an 
external flash device and Windows ReadyBoost 
to enhance system performance. 
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Device Manager

 Device Manager displays a list of all the devices 
installed in the computer, allowing you to 
diagnose and resolve device problems.

 The Device Manager utility uses icons to 
indicate the types of problems that may exist 
with a device.
• Update a driver - Change the currently 

installed driver.
• Roll back a driver - Change the currently 

installed driver to the previously installed 
driver.

• Uninstall a driver - Remove a driver.
• Disable a device - Disable a device.
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Devices and Printers

 Devices displayed in the Devices and Printers Control Panel item are typically external 
devices you can connect to your computer through a port such as USB, or a network 
connection.

 Devices and Printers also allows you to quickly add a 
new device to the computer. 

 In most cases, Windows will automatically install any 
necessary drivers that are required by the device. 

 Note that the desktop computer device in the figure 
shows a yellow triangle alert, indicating that there is a 
problem with the driver. 

 The green check mark next to a device indicates that is 
to be used as the default device. 

 Devices and Printers is very similar in Windows 
versions 7, 8, and 10.
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Sound

 Use the Sound Control Panel item to configure audio devices or change the 
sound scheme of the computer. 

 For example, you can change the email notification 
sound from a beep to a chime. 

 Sound also allows a user to choose which audio device 
is to be used for playback or recording.

 The Sound Control Panel utility is largely unchanged 
between Windows 7, 8, and 10.
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Clock

 Windows allows you to change the system time and date through the Date and 
Time control panel item, as shown in the figure. 

 You can also adjust your time zone. 
 Windows will automatically update the time settings when 

time changes occur. 
 The Windows clock will automatically synchronize with a 

time authority on the internet. This ensures that the time 
value is accurate.

 Time and Date is accessed through the Clock and Region 
Control Panel category in Windows 10. In Windows 7 
and 8, it is accessed through the Clock, Language, and 
Region Control Panel category.
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Region

 Windows allows you to change the format of numbers, currencies, dates, and 
times by using the Region Control Panel item.

 Windows 10 attempts to use location services to 
automatically detect the location of the computer. The 
location can also be set manually if the location can't be 
determined.

 Date and time setting formats can be changed by changing 
the display patterns available in the Date and Time formats 
area.

 Click Additional settings to change number and currency 
formats and the measurement system used in the region. 

 Additional date and time formats are also available.
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Language

 In Windows 7 and Windows 8, language can be configured through Control Panel 
items. This allowed users to install language packs that included fonts and other 
resources required by different languages.

 In Windows 10, this was moved to the Region settings 
app, shown in the figure. When adding a language, you 
can even choose to install Cortana support for voice 
commands in that language, if available.
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Programs and Features

 Use the Program and Features Control Panel items to uninstall a program from 
your computer. 

 It is important that applications be uninstalled either through the Programs and 
Features Control Panel item or from an uninstallation menu choice that is 
associated with the application in the Start menu.

 In addition, you can repair the installation of 
some programs that may have problems.

 You can troubleshoot problems with programs 
that were made for older versions of Windows.

 Finally, you can choose to manually install 
software from the network.
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Windows Features and Updates

 You can also activate or deactivate Windows features, as shown in the figure. 
 Programs and Features also allows you to 

view the Windows updates that have been 
installed, and uninstall specific updates if they 
are causing problems and don't have 
dependencies with other installed updates 
or software.
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Default Programs

 The Default Programs Control Panel item provides the means to configure the 
way that Windows handles files and the applications that are used to work with 
them. 

 Example: if you have multiple web browsers 
installed, you can choose which web browser 
will open to view a link that you have clicked 
on in an email or other file.

 Choose default applications, or which 
application opens for a specific file type. 

 For example, you can configure a JPEG 
graphics file to open in a browser, for viewing, 
or in a graphics editor.



ITE v7.0 69

Troubleshooting

 The Troubleshooting Control Panel item has a number of built-in scripts that are 
used to identify and solve common problems with many Windows components.

 The scripts run automatically and can be configured to automatically make the 
changes to fix the problems that are found. 

 You can also view when the troubleshooting 
scripts have been run in the past by using 
the View History feature.
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BitLocker Drive Encryption

 BitLocker is a service provided with Windows that will encrypt an entire volume of 
disk data so that it can't be read by unauthorized parties.

 Data can be lost if your computer or disk drives are stolen.
 In addition, when the computer is taken out of 

service, BitLocker can help insure that the hard 
drive can't be read when it has been removed 
from the computer and scrapped.

 The BitLocker Control Panel item enables you 
to control the way BitLocker operates.
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File Explorer and Folder Options

 File Explorer Options in Windows 10 permit changing a variety of settings 
regarding the way files are displayed in Windows Explorer or File Explorer.

 Folder Options in Windows 7 and 8 is very similar.
 In Windows 10, many of the most commonly used file and 

folder options can be found in the File Explorer ribbon.
 In Windows 8.1 some functions are present in the ribbon, 

but the selection is not as comprehensive as it is in 
Windows 10.

 In Windows 7, there is no ribbon, so the Control Panel 
must be used.
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11.3 SYSTEM ADMINISTRATION
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Administrative Tools Control Panel Item

 The Administrative Tools Control Panel item is a collection of tools that are used 
to monitor and configure Windows operation. 

 This Control Panel item has evolved over time. In Windows 7 it was somewhat 
limited.

 Microsoft added many different utilities in 
Windows 8.1.

 In Windows 10, the available tools changed 
slightly.

 The Administrative Tools Control Panel item is 
unusual in that it is a collection of shortcuts to 
an application.
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Computer Management

 One of the Administrative Tools items is the Computer Management console.
 It allows you to manage many aspects of your computer and remote computers in 

one tool.
 The Computer Management console provides access to three groups of utilities.
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Event Viewer
 Event Viewer allows viewing the history of application, security, and Windows system 

events. 
 Windows logs many events by their type or level:

• Information - A successful event. A driver or program has executed successfully.
• Warning - Indication of a potential problem with a software component that is not 

functioning ideally.
• Error - A problem exists, but no immediate action 

is required.
• Critical - Immediate attention is required. Usually 

related to system or software crashes or lockups.
• Success Audit (security only) - A security event 

has been successful. For example, a successful logon. 
• Failure Audit (security only) - A security event 

that has not been successful like failed attempts 
by someone attempting to log on.
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Local Users and Groups

 Local Users and Groups provides an efficient way of managing users. 
 You can create new users and assign those users to membership in Groups. 
 Groups have rights and permissions assigned that are suitable for different types of users. 
 Windows provides default user accounts and groups 

to make managing users easier:
• Administrators - Full control of the computer and 

access to all folders.
• Guests - Guests can access the computer through a 

temporary profile that is created at logon and 
deleted on logoff. Guest accounts are disabled by default.

• Users - Users can perform common tasks such as running 
applications and accessing local or network printers. A 
user profile is created and persists on the system.
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Performance Monitor

 The Performance Monitor is different from the performance information that is 
available through Task Manager and Resource Monitor.

 The purpose of the Performance Monitor 
administrative tool is the creation of 
detailed custom reports from very 
specific counters.
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Component Services and Data Sources

 Component Services is an administrative tool used by administrators and 
developers to deploy, configure, and manage Component Object Model (COM) 
components.

 COM is a way to allow the use of software components in distributed 
environments such as in 
enterprise, internet, and intranet 
applications.
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Services

 The Services console (SERVICES.MSC) allows you to manage all the services 
on your computer and remote computers. 

 A service is a type of application that runs in the background to achieve a specific 
goal, or wait for service requests.

 To reduce security risks, only start the 
necessary services.
• Index service can speed up file searches.
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Data Sources

 Data Sources is a tool used by administrators to add, remove, or manage data 
sources using Open Database Connectivity (ODBC). ODBC is a technology that 
programs use to access a wide range of databases or data sources. The tool is 
shown in the figure.
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Print Management

 The Print Management utility provides a detailed view of all of the printers that are 
available to a computer.

 It is not available in all Windows editions. It is available in Windows servers, Pro, 
Enterprise, and Ultimate editions.

 It enables efficient configuration and monitoring 
of directly attached and network printers, 
Including print queues for all printers to which it 
has access.

 It also allows the deployment of a printer 
configuration to multiple computers on a 
network through the use of group policies.
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Windows Memory Diagnostics

 The Windows Memory Diagnostics tool schedules a memory test that will be 
executed when the computer starts.

 It can be configured to automatically restart the computer or execute the test the 
next time the computer starts.

 The type of diagnostics to be run can be 
configured by pressing F1 from the diagnostic 
as it runs, as shown in the figure.

 The results of the test can be viewed by finding 
the memory diagnostic test result in the 
Windows Log folder in Event Viewer.
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System Information

 Administrators can use the System Information tool to collect and display information about 
local and remote computers.

 The System Information tool is designed to quickly find information about software, drivers, 
hardware configurations, and computer components.

 You can also create a file containing all the 
information about the computer. To export a 
System Information file, select File > Export, 
type the filename, choose a location, and click 
Save.

 The System Information utility can also display the 
configuration of other machines on the network.

 It can be opened from the command prompt by 
typing msinfo32, or it can be found in the 
Administrative Tools Control Panel item.
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System Configuration

 System Configuration (MSCONFIG) is a tool used to identify problems that keep 
Windows from starting correctly:
• General – Displays Normal startup, Diagnostic startup, and Selective startup.
• Boot – Choose the OS version to boot if more than one is present, or Safe 

boot.
• Services – Lists services that are started with the OS. Allows individual 

services to not be loaded on boot for troubleshooting purposes.
• Startup – In 7, it displays a list of all applications the automatically run when 

Windows starts. In 8.1 and 10, the user is referred to the same settings in Task 
Manager.

• Tools – Displays a list of diagnostic tools for help with troubleshooting.
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The Registry

 Every setting in Windows is stored in the Registry. When a user makes changes, 
the changes are stored in the Registry.

 The registry consists of a hierarchical arrangement of keys and subkeys 
represented as a tree. Levels of the subkey tree can be deeply nested with a 
maximum of 512 levels permitted.

 The registry exists as database files, called hives, associated with each of the top 
level registry keys. 

 Each key has values. The values consist of the name of the value, its data type, 
and the setting or data that is associated with the value. The values tell Windows 
how to operate.
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Registry Hives

Root Key Contents

HKKEY_LOCAL_MACHINE Information about the physical state of the computer including hardware 
configuration, network logon and security information, and Plug and Play 
information, etc.

HKEY_CURRENT_USER Data about the preferences of the currently logged on user, including 
personalization settings, default devices, and programs, etc.

HKEY_CLASSES_ROOT Settings about the file system, file associations, and shortcuts. 
Information here is used when you ask Windows to run a file or view a 
directory.

HKEY_USERS All of the configuration settings for the hardware and software configured 
on the computer for all users.

HKEY_CURRENT_CONFIG Information about the current hardware profile of the machine.



ITE v7.0 87

Regedit

 The Registry Editor allows an administrator to view or make changes to the 
Windows Registry. 

 Using the Registry Editor utility 
incorrectly could cause hardware, 
application, or OS problems, including 
having to reinstall the OS.

 The registry editor can only be opened 
from a search or command prompt.

 You can search for regedit and open it 
from the search results, or you can 
open a command or PowerShell 
prompt and type regedit. The figure shows the regedit utility with the value 

of the OneDrive subkey open for modification.
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Microsoft Management Console

 Microsoft Management Console (MMC) is an application that allows the 
creation of custom management consoles for collections of utilities and tools from 
Microsoft or other sources.

 When initially opened, the console is empty. 
Utilities and tools, known as snap-ins, can be 
added to the console. You can also add web 
page links, tasks, ActiveX controls, and folders.

 The console can then be saved and reopened 
when needed. This allows the construction of 
management consoles for specific purposes.

 The figure shows a new empty console with the 
dialog box for selecting and adding snap-ins.
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DxDiag

 DxDiag stands for DirectX Diagnostic Tool and is used to troubleshoot video 
diagnostic problems.

 It displays details for all DirectX 
components and drivers that are installed 
in a computer, as shown in the figure.

 DxDiag is run from a search or from the 
command line.

 DirectX is a software environment and 
interface for multimedia applications, 
especially games. It defines interfaces for 
2D and 3D graphics, audio, media 
encoders and decoders, etc.
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Disk Management Utility

 The Disk Management utility can be opened by right-clicking This 
PC or Computer and selecting Manage. It can also be opened through the 
Computer Management Control Panel or in its own Window by using 
the Win+X menu and selecting Disk Management.

 In addition to extending and shrinking partitions, 
you can also use the Disk Management utility to 
complete the following tasks:
• View drive status
• Assign or change drive letters
• Add drives
• Add arrays
• Designate the active partition
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Drive Status

 Disk Management utility displays the status of each disk. The drives display one of the 
following conditions:
 Foreign - A dynamic disk 

that has been moved from 
another computer running 
Windows

 Healthy - A volume that is 
functioning properly

 Initializing - A basic disk 
that is being converted into a 
dynamic disk

 Missing - A dynamic disk 
that is corrupted, turned off, 
or disconnected

 Not Initialized - A disk that 
does not contain a valid 
signature

 Online - A basic or dynamic 
disk that is accessible and 
shows no problems

 Online (Errors) - I/O errors 
detected on a dynamic disk

 Offline - A dynamic disk that 
is corrupted or unavailable

 Unreadable - A basic or 
dynamic disk that has 
experienced hardware 
failure, corruption, or I/O 
errors
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Mounting a Drive

 Mounting a drive refers to making a disk image file readable as a drive. 
 ISO files can have their contents written to disk but they can also be mounted on virtual 

drives. 
 To mount an image, open File Explorer, select an ISO file, in the ribbon select the Manage 

menu under Disk Image Tools and 
select Mount.

 The ISO file will be mounted as a removable 
media drive. 

 The drive is an ISO image mounted as a 
volume.

 You can also create a mount point which is 
similar to a shortcut.

 You can create a mount point that makes an 
entire drive appear as a folder.
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Adding Arrays

 In Windows 10 disk management, you can create 
spanned (RAID 0), mirrored (RAID 1), or RAID 5
arrays from multiple dynamic disks.
• This is done by right-clicking a volume and selecting 

the type of multidisc volume that you want to create.
• There must be two or more initialized dynamic drives 

available on the computer.
 Storage Spaces is available in Windows 8 and 10.

• Storage Spaces is the disk array technology 
recommended by Windows. It creates pools of 
physical hard drives from which virtual disks (storage 
spaces) can be created. 

• Like other disk arrays, Storage Spaces offer mirrored, 
striped, and parity options.
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RAID Levels
Level Features
Level 0 Striped Disk Array without Fault Tolerance
Level 1 Mirroring and Duplexing
Level 2 Error-Correcting Coding
Level 3 Parallel transfer with parity
Level 4 Independent Data disks with shared Parity disk 
Level 5 Striping with distributed parity blocks 
Level 6 Independent Data disks with two independent distributed parity schemes
Level 7 Optimized Asynchrony for High I/O Rates
Level 10 A Stripe of Mirrors
Level 53 High I/O Rates and Data Transfer Performance
Level 0+1 A Mirror of Stripes

On a spanned volume, data is seen as one volume, but is stored across two or more disks. 
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Disk Optimization
 To maintain and optimize disk storage, use various tools within 

Windows.
 A disk defragmenter gathers the noncontiguous data into one place, 

making the OS run faster.
 Do not perform disk defragmentation on SSDs.
 SSDs are optimized by their own controller and firmware.
 It should not be harmful to defragment Hybrid SSDs because they 

use hard disks to store data.
 In Windows 8 and 10, the option is called Optimize. In Windows 7, it 

is called Defragment Now accessed from the disk properties menu 
or from the File Explorer ribbon in Windows 8 and 10.

 The Optimize Drives utility allows analysis of the drive prior to 
optimization.

 You can also optimize the available space by doing a disk Cleanup 
operation.
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Disk Error-Checking

 The Disk Error-Checking tool checks the integrity of files and folders by scanning the hard 
disk surface for physical errors.

 The tool fixes file system errors and checks the disk for bad sectors. It also attempts to 
recover data from bad sectors. 

 In File Explorer or File Manager, right-click the drive and 
select Properties. Select the Tools tab and select Check or
Check Now in Windows 7.

 In Windows 8, select Scan Drive to attempt to recover bad 
sectors. In Windows 7, select Scan for and attempt recovery 
of bad sectors and click Start.

 In Windows 8 and 10, click Check Results after scanning. 
This will open an Event Viewer window that will allow you to 
view the log entry for the scan.
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System Requirements

 Before purchasing or attempting to install an application, you should verify that the 
system requirements are met. Requirements are normally defined in the software 
packaging or on the software download page:
• Processor speed - 32 or 64-bit, x86 or other
• RAM - sometimes as minimum or recommended capacities
• Operating System - and version
• Hard disk space - available
• Software dependencies - runtime and other frameworks or environments may 

be required to be present in order for the software to run
• Graphics and display
• Network access - if any
• Peripheral devices



ITE v7.0 98

Installation Methods

 Most applications use an automatic installation process when the application disc 
is inserted in the optical drive. 

 The user is required to click through the installation wizard and provide 
information when requested. 

 Most Windows software installations are attended, meaning the user must be 
present to interact with the installer software to provide input about the options to 
use when installing the software.

 The various types of installations 
are defined in the figure.

Method Definition

Attended A user must be present to respond to prompts from the installer 
software.

Silent or unattended No prompts or other information is displayed during installation.

Scheduled or automated
Installation that occurs without being started by a user. 
Preconfigured tasks that run according to conditions or timers can 
install software when appropriate.

Clean All components of any previous version of the software have been 
removed prior to installation.

Network The installation packages are available on a server and the 
installation occurs across the network.
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Installing an Application

 Local installation can occur from the hard drive, CD, DVD, or USB media.
 To perform a local, attended installation, insert the media or drive, or open the 

downloaded program file.
 If the software installation does not start automatically 

you will need to browse the installation media in order 
to find and execute the installer.

 Installer software usually has an EXE or MSI 
(Microsoft Silent Installer) file extension.

 If there are problems, repair or uninstall the 
application.

 In addition to the process described above, 
Windows 8 and 10 provide access to the Microsoft 
Store, as shown in the figure.



ITE v7.0 100

Compatibility Mode

 Older applications may not run properly on newer 
Windows operating systems.

 If older software is not running properly, locate the 
executable file for the application. This can be done by 
right-clicking a shortcut for the application and 
selecting Open file location.

 Right-click the executable file and choose Properties.
 From the Compatibility tab, shown in the figure, you can 

run the Windows compatibility troubleshooter or manually 
configure the Compatibility Mode environment for the 
application.
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Uninstalling or Changing a Program

 If an application is uninstalled incorrectly, you might be leaving files on the hard drive and 
unnecessary settings in the registry, which wastes hard drive space and system resources.

 Unnecessary files might also reduce the speed at which the registry is read. Microsoft 
recommends that you always use the Programs and Features Control Panel utility when 
removing, changing, or repairing applications. 

 The utility guides you through the software removal 
process and removes every file that was installed, as 
shown in the figure.

 Some applications may include an uninstall feature that 
is located in the Windows Start menu with the 
application.
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Security Considerations

 Allowing users to install software on computers that are owned by a business 
organization can be a security risk. 

 Users can be tricked into downloading malicious software that can cause data 
loss, either through theft or destruction. 

 Malicious software, known as malware, can 
infect all computers that are attached to a 
network and can cause widespread damage 
and loss.

 As a technician, it is important to enforce 
policies regarding software installation and 
ensure that antimalware software, such as 
Windows Defender, is active and up to date.
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11.4 COMMAND-LINE TOOLS
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PowerShell

 The old Windows command line application was replaced in the Windows Power User menu 
Win+X with PowerShell.

 The original command line still exists in Windows 10, and can be opened by typing cmd into 
the search field on the Taskbar. You can also change which command line is displayed in 
the menu by changing a Taskbar setting.

 PowerShell is a more powerful command line utility. It 
offers advanced features, such as scripting and 
automation. It comes with its own scripting development 
environment, called PowerShell ISE.

 PowerShell uses "cmdlets", or small applications, that 
represent the commands that are available. PowerShell 
also allows naming of cmdlets with aliases.

 The figure shows Windows ISE. PowerShell can also be 
opened as the command line shell alone.
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The Command Shell

 Windows has two command line utilities. PowerShell and the classic Command
Prompt application, known as cmd.

 CMD has been the default command line for Windows until PowerShell with 
Windows 10 build 14791

 To open the command shell, type cmd in the 
search box and click the app in the results. 

 Or, use the Win+R key to open a run box 
and type cmd in the run box and click OK. 

 Press Ctrl+Shift+Enter to run the command 
prompt as an administrator.

 All commonly used commands are 
supported by Windows 7, 8, and 10.



ITE v7.0 106

Basic Commands

 help – get information on commands
 command /? – get help on a specific command
 cls – clear the screen
 Up-arrow keys – move through 

previously entered commands
 F7 key – display command history in 

an overlay window 
 Ctrl+C key – exit a running command 

process or script
 exit – close the command window
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Command Syntax Conventions

 Many conventions used by Microsoft for CLI commands are summarized in the figure.
 Special characters, called wildcards, can be substituted for characters or groups of 

characters in filenames.
 Wildcards can be used when you only know part of a filename that you are trying to find or 

when you want to perform a file operation on a group of files that share elements of a 
filename or extension.

 The two wildcards that can be used at the Windows command line are:
• The asterisk (*) - This character matches groups of characters, including entire filenames 

and file extensions.
• The question mark (?) - This 

character stands for any single 
character. It does not stand for a 
group of characters.

Notation Description

Text without brackets or braces Must be typed exactly as shown.

<Text inside angle brackets> A value that must be supplied.

[Text inside square brackets) Optional input.

(Text inside braces} Must choose one of the list of items.

Vertical bar (I) Mutually exclusive items.

Ellipsis (...) Repeatable input.
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File System Navigation

 When working at the command line, there is no File Explorer to help you get to the 
files and folders that you want to work with. Instead, you need to move through 
the folder structure using a combination of commands, normally displaying the 
contents of a drive or directory and changing directories until you find what you 
are looking for.



ITE v7.0 109

File System Navigation - Commands

 <drive>: – display contents from a different 
drive like:  d:

 dir – display the contents of the current directory
 cd – change directory
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Manipulating Folders - Commands

 md – make directory. Create a new directory
 rd – remove directory. Delete a directory
 move – move a file or directory from one directory to another
 ren – rename a directory or file



ITE v7.0 111

Manipulating Files - Commands

 > – redirect. Send the output of a command to a file
example: dir > directory.txt

 type – display the contents of a file
 more – display the contents of a file one screen at a time
 del – delete a file or folder
 copy – make a copy of a file
 xcopy – extended copy. Copy files or entire 

directory trees
 robocopy – robust copy. Copy files and entire 

directory trees
 move – move a file from a source location to a 

destination location
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Disk Operations - Commands

 chkdsk – check disk. Checks a file system for errors, including errors with 
physical media

 format – creates a new file system for a disk. May also check for physical disk 
errors

 diskpart – starts a separate command interpreter 
with commands for working with disk partitions
• list
• select
• clean
• create
• format
• assign
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System CLI Commands

 tasklist - displays a list of the processes that are currently running on the local 
or remote computer

 taskkill - allows a running process to be killed
• taskkill /im Program.exe /f
• taskkill /pid pid# /f

 dism - Deployment Image Servicing and 
Management. Used to work with system 
images before they are deployed

 sfc - verifies and repairs Windows system 
files

 shutdown - power off a local or remote 
computer
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Other Useful Commands

 gpupdate - group policy update
• /target:computer – force update of another computer
• /force – force and update even if Group Policy has not changed
• /boot – restart computer after update

 gpresult - display Group Policy Resultant Set of Policy (RSoP) information
• /s – the system to view the result on, name or ip address  
• /r – displays summary data

 net use - display and connect to network resources
 net user - display and change information 

about computer users
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Running System Utilities

 The Windows run line utility can be opened by pressing the Win+R keys and 
entering cmd to open the command line window, as shown here. The following 
windows utilities and tools can also be run by entering the commands shown in 
the run line utility:

 EXPLORER - Opens File Explorer or Windows Explorer
 MMC - Opens Microsoft Management Console (MMC). Specify the path and .msc

filename to open a saved console
 MSINFO32 - Opens the System Information window, 

which shows a summary of system components, 
including hardware components and software information

 MSTSC - Opens the Remote Desktop utility
 NOTEPAD - Opens the Notepad basic text editor
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11.5 WINDOWS NETWORKING
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Domain and Workgroup

 Domain - A domain is a group of computers and electronic devices with a 
common set of rules and procedures administered as a unit. Computers in a 
domain can be located in different locations in the world. A specialized server 
called a domain controller manages all security-related aspects of users and 
network resources, centralizing security and administration. 

 Workgroup - A workgroup is a collection of workstations and servers on a LAN 
that are designed to communicate 
and exchange data with one 
another. Each individual 
workstation controls its user 
accounts, security information, and 
access to data and resources.



ITE v7.0 118

Homegroup
 Homegroup has been removed from Windows 10
 There can only be one homegroup per workgroup on a network and computers can only be 

a member of one homegroup at a time. 
 Homegroups are secured with a simple password.
 One user in the workgroup creates the homegroup. The other users can join the 

homegroup, provided they know the homegroup password. 
 Homegroup availability depends on your network location profile:

• Home Network - allowed to create or join a 
homegroup

• Work Network - not allowed to create or join a homegroup, 
but you can view and share resources with other 
computers

• Public Network - homegroup not available
 When a computer joins a homegroup, all user accounts on 

the computer, except the Guest account, become members of the homegroup. 
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Network Shares and Mapping Drives
 Network file sharing and mapping network drives is a secure and convenient way 

to provide easy access to network resources.
 Nearby device file sharing provides simple file sharing via Wi-Fi and Bluetooth. 
 Permissions define the type of access a user has to a file or folder:

• Read - the user can view the file and subfolder names, navigate to subfolders, 
view data in files, and run program files.

• Change - in address to Read permissions the 
user can add files and subfolders, change the 
data in files and delete subfolders and files.

• Full Control - in addition to change and read 
permissions, the user can change the permission 
of files and folders in an NTFS partition and take 
ownership of files and folders.
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Administrative Shares
 Administrative shares, also called hidden shares, are identified with a dollar sign ($) at the 

end of the share name.
 By default, Windows creates several hidden administrative shares. These include the root 

folder of any local drives (C$), the system folder (ADMIN$), and the print driver folder 
(PRINT$).

 Administrative shares are hidden from users and only accessible by members of the local 
administrators’ group.

 The figure shows administrative shares on a 
Windows 10 PC. Note the $ after each share 
name, making them hidden shares.

 Adding a $ sign to the end of any local share 
name will cause it to become a hidden share. It 
will not be visible by browsing but can be 
accessed via the command-line by mapping a 
drive to the share name.
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Sharing Local Resources

 Windows 10 controls which resources are shared and how they are shared by turning 
specific sharing features on and off.

 Advanced Sharing Settings, located in the Network and Sharing Center, manages the 
sharing options for three different network profiles; Private, Guest or Public, and All 
Networks.

 Different options can be chosen for each profile. The following items can be controlled:
• Network discovery
• File and printer sharing
• Public folder sharing
• Password protected sharing
• Media Streaming

 To enable sharing resources between computers 
connected to the same workgroup, Network Discovery 
and File and printer sharing must be turned on, as shown here.
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Printer Sharing vs. Network Printer Mapping

 A local printer can be shared on the network via the Sharing tab on the Printer 
Properties dialog box as shown here.

 Once a printer is shared, users with the correct permissions can connect to the 
shared printer over the network.

 Drivers for the printer can be installed on the local 
computer so that clients obtain the drivers when 
they connect to the print share.

 To find the shared printer on the network, users 
can browse through network resources.

Printer Sharing
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Configuring Wired Network Interfaces in Windows 10

 Windows 10 network settings are managed through the Network & Internet 
section in the Settings App. 

 From the Network & Internet window, there are links to View 
network properties and to the Network and Sharing Center. 

 Available network connections, both wired and wireless, can 
be viewed by selecting the Change Adapter Options link. 
From there, each network connection can be configured.
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Configuring a Wired NIC

 After the NIC driver is installed the IP address settings must be configured. A 
computer can be assigned its IP configuration in one of two ways:
• Manually - The host is statically assigned a specific IP configuration
• Dynamically - The host requests its IP address configuration from a DHCP 

server
 From the properties window of the 

wired NIC, both IPv4 and IPv6 
addresses and other options such 
as the default gateway and DNS 
server address can be configured.



ITE v7.0 125

Setting a Network Profile

 The first time a computer with Windows 10 connects to a network, a network 
profile must be selected. Each network profile has different default settings. 
Depending on the profile selected, file and printer sharing, or network discovery 
can be turned off or on, and different firewall settings can be applied.

 Windows 10 has two network profiles:
• Public – The public profile disables file and printer 

sharing and network discovery on the link. The PC 
is hidden from other devices.

• Private – The private profile allows the user to 
customize the sharing options. This profile is for 
use on trusted networks. The PC is discoverable 
by other devices.
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Verify Connectivity with the Windows GUI

 The easiest way to test for an internet connection is to open a web browser and 
see if the internet is available. To troubleshoot a connection, you can use the 
Windows GUI or CLI.

 In Windows 10, the status of a network connection 
can be viewed under the General tab, as shown here. 
Click the Details button to view IP addressing 
information, subnet mask, default gateway, MAC 
address, and other information.
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ipconfig Command

 The ipconfig command displays basic IP configuration information, including the IP address, 
subnet mask, and default gateway for all network adapters to which TCP/IP is bound.

 There are several ipconfig switches and arguments which are useful to know. The table in 
the figure displays available command options. To use a command option, enter the 
ipconfig /option (e.g., ipconfig /all).

Ipconfig Argument Description

ipconfig /all Displays additional network configuration information including DHCP and DNS servers, 
MAC address, NetBIOS status, and domain name.

ipconfig /release Releases the IP address learned from the DHCP server resulting in the network 
adapter(s) no longer having an IP address.

ipconfig /renew Forces a DHCP client to renew its DHCP address lease from the DHCP server.

ipconfig /displaydns Displays the DNS resolver cache which contains host and domain names that have been 
recently queried.

ipconfig /flushdns Clears the DNS resolver cache on the host.
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Network CLI Commands

 The following CLI commands that can be executed from the command prompt to 
test network connectivity:
• ping – This command tests basic connectivity between devices by using ICMP 

echo request and reply messages.
• tracert – This command traces the route that packets take from your 

computer to a destination host. At the command prompt, enter tracerthostname.
• nslookup – This command tests and troubleshoots DNS servers. It queries the 

DNS server to discover IP addresses or host names. At the command prompt, 
enter nslookup hostname to return the IP address for the host 
name entered.

• netstat – This command displays all active TCP connections.
• A reverse nslookup command, nslookup IP_address returns 

the host name for the IP address entered.
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Wireless Settings
 Wireless networks can be added in Windows 10 by going to Settings > Network & Internet > 

Wi-Fi > Manage known networks
• Enter the network name and select a security type that matches the configuration on the 

wireless router. 
 There are four security type options:

• No authentication (Open) – Data is sent unencrypted 
and with no authentication

• WEP – Provides very weak security and should not be 
relied upon for confidentiality

• WPA2-Personal – Uses the Advanced Encryption 
Standard (AES) cipher and a Pre-shared Key (PSK) to 
encrypt communications

• WPA2-Enterprise – Authentication is passed from the access point to a centralized 
authentication server running Remote Authentication Dial-in User Service (RADIUS) or 
Terminal Access Controller Access Control System (TACACS).
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VPN Access in Windows

 A Virtual Private Network (VPN) is a private network that connects remote sites 
or users together over a public network, like the internet.

 When VPN connects to the corporate private network, users become part of that 
network and have access to all services and resources as if they were physically 
connected to it.

 Remote-access users must install a VPN client on 
their computers to form a secure connection to a 
corporate private network.

 The VPN software encrypts data before sending it 
over the internet.

 VPN gateways establish, manage, and control VPN 
connections, also known as VPN tunnels.

 A VPN in Windows 10 can be set up from the Network and Sharing Center.
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Telnet and SSH
 Telnet is sometimes used for troubleshooting services or connecting to routers 

and switches. 
 Messages are sent in clear text so anyone with a packet sniffer can capture and 

see the contents of Telnet messages.
 Communicates over TCP port 23. 
 Must be turn On in Windows 10.
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SSH
 Secure Shell (SSH) is an encrypted alternative to Telnet and other file copy 

programs such as FTP. 
 Communicates over TCP port 22. 
 Use to securely access and configure other devices.
 SSH server authentication methods include:

• Username/Password - The client sends credentials to the SSH host, which are 
then verified

• Kerberos - Networks which use Kerberos authentication protocol, such as 
Windows Active Directory, allow for Single Sign-On (SSO)

• Host-based authentication - The client requests authentication with a public 
key. The server generates a challenge with this key which the client must 
decrypt with the matching private key

• Public key authentication - The user enters a passphrase to access the 
private key. 
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11.6 COMMON PREVENTIVE 
MAINTENANCE TECHNIQUES FOR 
OPERATING SYSTEMS
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Preventive Maintenance Plan Contents
 A preventive maintenance plan provides many benefits to users and organizations 

such as decreased downtime, improved performance, improved reliability, and 
lower repair costs.

 Preventive maintenance plans should prioritize equipment that would affect the 
organization the most if that equipment fails.

 Preventive maintenance for an OS includes automating tasks to perform 
scheduled updates, and installing service packs.

 Preventive maintenance includes the following important tasks: 
• Hard drive error checking
• Defragmentation
• Backups
• Updates to the operating system, applications, antivirus, and 

other protective software.
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Windows Updates
 Windows Update is a website located at update.microsoft.com. The site hosts 

maintenance updates, critical updates, and security patches as well as optional 
software and hardware updates for Microsoft Windows versions 7, 8 and 10.

 Microsoft releases updates on the second Tuesday of each month, unofficially 
known as Patch Tuesday.

 Windows 10 automatically downloads and installs 
updates to make sure your device is secure and up to 
date.

 You can manually check for updates in Windows 10 
via Settings > Update and Security.

 If Windows 10 will not run updates automatically or 
manually, you can delete all the files in the 
C:\Windows\SoftwareDistribution folder and 
restart the PC. 
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Restore Points

 Sometimes installing an application or hardware driver can cause instability or create 
unexpected problems.

 If uninstalling the application or hardware driver doesn't correct the problem, you can restore 
the computer to a previous point in time with the System Restore utility.

 If a computer crashes or if an update causes a problem, the computer can be rolled back to 
a previous configuration using a restore point. 

 System restore does not back up personal data files, nor does 
it recover personal files that have been corrupted or deleted.

 Create a restore point before making changes to a system in 
the following situations:
• When updating the OS
• When installing or upgrading hardware
• When installing an application
• When installing a driver
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Hard Drive Backup

 It is important to establish a backup strategy that includes data recovery of personal files. 
You can use the Microsoft Backup utility to perform backups as required.

 It can take a long time to run a backup. If the backup strategy is followed carefully, it is not 
necessary to back up all files every time. Only the files that have changed since the last 
backup need to be backed up.

 The backup tool included with Windows 7 allowed users to back up files, or create and use a 
system image backup, or repair disc. Windows 8 and 
Windows 10 ship with File History which can be used to back 
up the files in the Documents, Music, Pictures, Videos, and 
Desktop folders. Over time, File History builds a history of your 
files, allowing you to go back and recover specific versions of a 
file. 

 File History in Windows 10 is located in Settings > 
Update&Security > Backup, as shown here.
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Advanced Startup

 Whether you need to repair Windows 10, run Startup Repair, reset the OS, 
access the BIOS, restore from a backup file, boot into safe mode or just disable 
the auto restart function, you must navigate to the Advanced Startup Options 
menu. 

 There are several different ways to navigate to Advanced Startup Options, 
depending on whether you can boot up or not:
• Hit F11 as soon as the computer powers on
• Boot from an Install disk
• Restart with the Shift Key down
• Navigate to Settings > Update & Security > Recovery

> Restart Now
• Wait for your computer to take you there after several

startup errors
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11.7 APPLYING TROUBLESHOOTING 
PROCESS TO WINDOWS OPERATING 
SYSTEMS
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The Troubleshooting Process
Most operating systems contain utilities to assist in the troubleshooting process. 
These utilities help a technician to determine why the computer crashes or does not 
boot properly. The utilities also help identify the problem and how to resolve it.
Step 1 Identify the problem
Step 2  Establish a theory of probable causes
Step 3  Test the Theory to Determine cause
Step 4  Establish a Plan of Action to Resolve 

the Problem and Implement the 
Solution

Step 5 Verify Full System Functionality and 
Implement Preventative Measures

Step 6 Document Findings, Actions, and 
Outcomes
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Step 1 – Identify the Problem

Open-ended questions

• What problems are you having?
• What operating system is installed on the computer?
• What updates have you performed lately?
• What programs have you installed recently?
• What were you doing when the problem was discovered?

Closed-ended questions

• Can you start the operating system?
• Can you start the operating system in safe mode?
• Have you changed your password recently?
• Have you seen any error messages on the computer?
• Has anyone else used the computer recently?
• Has any hardware been added recently?
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Step 2 – Establish a Theory of Probable Cause

Common causes of 
operating system problems

• Incorrect settings in BIOS
• Caps lock key is set to on
• Non-bootable media during computer
• boot up
• Password has changed
• Incorrect monitor settings in control
• Panel
• Operating system update failure
• Driver update failure
• Malware infection
• Hard drive failure
• Corrupt operating system files

Restarting can fix many issues with network connectivity and application errors.
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Step 3 – Test the Theory to Determine Cause

Common steps to 
determine cause

• Log in as a different user
• Use third party diagnostic software
• Determine if new software or software updates have just been 

installed
• Uninstall recently installed applications
• Boot into safe mode to determine if the problem is driver-related
• Roll back newly updated drivers
• Examine Device Manager for device conflicts
• Examine Event logs for warnings or errors
• Check the hard drive for errors and fix file system issues
• Use the system file checker to recover corrupt system files
• Use system restore if a system update or service pack has been 

installed
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Step 4 – Establish a Plan of Action to Resolve the Problem 
and Implement the Solution

If no solution is achieved in the 
previous step, further research 
needed to implement the solution.

• Helpdesk repair logs
• Other technicians
• Manufacturer FAQ websites
• Technical websites
• News groups
• Computer manuals
• Device manuals
• Online forums
• Internet search

When installing an OS, it may be necessary to change the boot sequence in 
the BIOS.
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Step 5 – Verify Full System Functionality and if Applicable, 
Implement Preventive Measures

Verify full functionality • Shut down the computer and restart it
• Check event logs to make sure there are no new warnings or errors
• Check Device Manager to see that there are no warnings or errors
• Run DxDiag to make sure DirectX is running correctly
• Make sure applications run properly
• Make sure network shares are accessible
• Make sure the Internet can be accessed
• Re-run system file checker to ensure all files are correct
• Check Task Manager to ensure that the status of all programs is 

Running
• Re-run any third party diagnostic tools
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Step 6 – Document Findings, Actions, and Outcomes

Document findings, 
actions, and outcomes.

• Discuss the solution implemented with the customer
• Have the customer verify that the problem has been solved
• Provide the customer with all paperwork
• Document the steps taken to solve the problem in the work 

order and the technician's journal
• Document any components used in the repair
• Document the time spent to resolve the problem
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Common Problems and Solutions
The OS locks up

Probable Causes Possible Solutions

The computer is overheating.

Some of the operating system files may 
be corrupted.

The power supply, RAM, hard drive, or 
motherboard may be defective.

The BIOS settings may be incorrect.

An unknown event has occurred that 
has caused the OS to lock up.

Clean internal components.

Check the fan connections to ensure fans are operating 
properly.

Run the system file checker (SFC) to replace corrupt 
operating system files.

Test the power supply, RAM, hard drive, or motherboard 
with third party diagnostic software and replace as 
necessary.

Examine and adjust the BIOS settings. Address any 
events in the Event Log. Install or roll back updated 
drivers.
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Advanced Problems and Solutions for Operating Systems
The computer displays an " Invalid Boot Disk" error after the POST.

Probable Causes Possible Solutions

Media that does not have an operating 
system is in a drive.

Remove all media from the drives.

The boot order is not set correctly in the 
BIOS/UEFI settings.

Change the boot order in the BIOS/UEFI settings to 
start with the boot drive.

The hard drive is not detected. Reconnect the hard drive cables.

The hard drive does not have an operating 
system installed.

Install an operating system.

The MBR/GPT is corrupted. Use the bootrec /fixmbr command from the System.

The computer has a boot sector virus. Recovery options of Windows 7 or Vista.

The hard drive is failing. Run virus removal software. 
Replace the hard drive.
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11.8 CHAPTER SUMMARY
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Windows Configuration

 Configure the Windows Desktop and File Explorer.
 Configure Windows using Control Panels.
 Use Windows tools and utilities to manage Windows systems.
 Use Microsoft Windows command line tools.
 Configure a Windows computer to work on a network.
 Use common preventive maintenance techniques for Microsoft Windows 

operating systems.
 Troubleshoot Microsoft Windows operating systems.
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New Terms and Commands
• Peer-to-Peer File Sharing
• Small Office/Home Office or 

SOHO
• Medium to large network
• Server
• Client
• Peer-to-Peer network
• End device
• Intermediary device
• Medium
• Network Interface Card (NIC)
• Physical Port
• Interface
• Physical topology diagram

• Logical topology diagram
• Local Area Network (LAN)
• Wide Area Network (WAN)
• Internet
• Intranet
• Extranet
• Internet Service Provider (ISP)
• Converged networks
• Network architecture
• Fault tolerant network
• Packet-switched network
• Circuit-switched network
• Scalable network
• Quality of Service (Qos)

• Network bandwidth
• Bring Your Own Device (BYOD)
• Collaboration 
• Cloud computing
• Private clouds
• Hybrid clouds
• Public clouds
• Custom clouds
• Data center
• Smart home technology
• Powerline networking
• Wireless Internet Service 

Provider (WISP)
• Network architecture
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